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1 Introduction
Topics covered in this chapter:

• User Guide conventions

• Technical support

• Certification and operation

• Precautions

1.1 User Guide conventions
The following conventions are used throughout this User Guide.

Note
A note paragraph contains special comments or instructions.

CAUTION!

A caution paragraph alerts you to actions that may have a major impact on the equipment or
stored data.

WARNING!

A warning paragraph alerts you to actions that may have extremely serious consequences for
equipment and/or personnel.

1.2 Technical support

Hardware Technical Help

Please have the number of the current version of your firmware ready when you call. For
the CSI 2125-IS, select About from the Main Menu to see details such as Unit ID and
Firmware Version.

If you have a problem, explain the exact nature of your problem. For example, what are the
error messages? When do they occur? Know what you were doing when the problem
occurred. For example, what mode were you in? What steps did you go through? Try to
determine before you call whether the problem is repeatable.

Introduction
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Software Technical Help

Please provide the software version numbers of your Windows® operating system and
AMS Suite: Machinery Health Manager. In AMS Machinery Manager, select Help > About.

If you have a problem, explain the exact nature of your problem. For example, what are the
error messages? (If possible, take a screen capture of the error message.) When do they
occur? Know what you were doing when the problem occurred. For example, what mode
were you in? What steps did you go through? Try to determine before you call whether the
problem is repeatable.

Please be at your computer when you call. We can serve you better when we can work
through the problem together.

Software Technical Support

Emerson Process Management provides technical support through the following for those
with an active support agreement:

• Telephone assistance and communication via the Internet.

• Mass updates that are released during that time.

• Interim updates upon request. Please contact Emerson Process Management
Technical Support for more information.

Contact information

For Emerson Technical Support and Customer Service Toll Free numbers, email addresses,
and hours of operation, please visit 
http://www2.emersonprocess.com/en-US/brands/sureservice/Pages/TechnicalSupport.aspx

1.3 Certification and operation
Refer to the document titled "Instructions" included with the analyzer for certification
details and important safety instructions. Please read and adhere to the important safety
instructions at all times.

The following instructions describe requirements for operation in hazardous areas. The CSI
2125-IS has been certified for use ONLY with the supplied power adapter when in a Non
Hazardous Area. Any attempt to charge or power the analyzer from any other source will
render the analyzer’s certification permanently invalid.

The SIGNAL socket of the CSI 2125-IS can only be connected to the following tranducers by
the CA-40 cable:

Type Brand and Model

Accelerometer Monitran MTN/1100l

Wilcoxon 793-35

Wilcoxon 797-35
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The TRIGGER socket of the CSI 2125-IS can only be connected to the following tachometer
by the CA-61 cable:

Type Brand and Model

Hand Tachometer Compact Instruments Ltd model A2109.

When used with the model A2109, this equipment is only suitable for use as
Category 2G due to the A2109 having Category 2G/zone1 assessment only.

Third party accessories such as a tachometer, accelerometer, and cables cannot be used
with the CSI 2125-IS in a Hazardous Area. If you are unsure of which accessories can be
used in hazardous areas please contact Emerson Process Management Technical Support.

WARNING!

Connect the analyzer to the power adapter only in a Non Hazardous Area.

WARNING!

Open the battery access door only in a Non Hazardous Area.

WARNING!

Charge the battery only in a Non Hazardous Area.

WARNING!

Connect the analyzer to a computer only in a Non Hazardous Area.

WARNING!

Only update the firmware in a Non Hazardous Area.

1.4 Precautions
Cleaning

The analyzer is dust resistant. Use a damp, clean cloth for cleaning. Do not use cleaning
fluids, abrasives, or aerosols. They could enter the analyzer, causing damage, fire or
electrical shock. These substances may also mar the finish of the analyzer.

Avoid water

The analyzer is splash resistant. However, avoid direct contact with water, wet surfaces, or
condensing humidity. Keep away from wet locations such as sinks, laundry, wet
basements, swimming pools, and so on. If the analyzer is subjected to these conditions,
adverse operation may result. If the surface of the analyzer becomes wet, allow it to dry
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thoroughly before operation. This analyzer is not certified for use with a Compact Flash
card. However, if the analyzer has a card door, do not open the card door in locations
where water or other contaminants could enter the analyzer.

Avoid damage or injury

Follow these guidelines to avoid costly damage or injury:

• Place the analyzer on a solid, stable surface when not in use and do not place any
heavy objects on it.

• Use only accessories recommended by Emerson Process Management.

• Keep liquids and foreign objects away from your analyzer.

• Never operate your analyzer if any liquid or foreign object has entered it.

• This analyzer is not certified for use with a Compact Flash card. If the analyzer has a
card door, do not enter any other object other than recommended PCMCIA type
cards into the PCMCIA opening. Electrical shock could result, causing fire or shock
hazards as well as damage to your analyzer.

Introduction
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2 Introduction to the analyzer
Topics covered in this chapter:

• CSI 2125-IS Machinery Health Analyzer

• Analyzer buttons and LED lights

• Connectors

• Battery access door and reset switch

2.1 CSI 2125-IS Machinery Health Analyzer
The CSI 2125-IS Machinery Health Analyzer is an intrinsically safe vibration analyzer that
allows you to perform route-based and off-route data collection on equipment in a
Hazardous Area. The CSI 2125-IS Machinery Health Analyzer has an internal (Nickel Metal
Hydride) battery for use in a Hazardous Area. With AMS Suite: Machinery Health Manager,
you can use the Data Transfer program to load routes on the analyzer and upload the
collected data to perform analysis and reporting.

Due to the restrictions imposed on the hardware design by Intrinsic Safety design rules,
the CSI 2125-IS responds more slowly to button presses than other CSI-branded analyzers.
Give the analyzer a moment to respond to button presses.

2.2 Analyzer buttons and LED lights

Analyzer buttons and LED lightsFigure 2-1:   

A. Numeric keys
B. Arrow keys
C. Enter
D. Red LED
E. Amber LED
F. Green LED
G. Software function keys
H. Power
I. Rubber protective boot

Introduction to the analyzer
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2.3 Connectors

ConnectorsFigure 2-2:   

A. Trigger - Tachometer input
B. Charger - Power adapter connection
C. RS232 - Computer connection
D. Signal - Vibration sensor input

2.4 Battery access door and reset switch

Battery access door and reset switch locationFigure 2-3:   

A. Reset switch location (visible when battery access
door is open)

B. quarter-turn fasteners
C. Battery access door

Introduction to the analyzer
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3 Operate the analyzer
Topics covered in this chapter:

• Turn the analyzer on and off

• Using the touchscreen interface

• Calibrate the touchscreen interface

• Assemble the strap

• Display hardware and firmware details

• Charge the battery

• Display the battery status

• Remove and refit the battery pack

• Reboot the analyzer

• Perform a hardware reset

• Update the CSI 2125-IS firmware

• Adjust the display contrast

• Open context sensitive help

3.1 Turn the analyzer on and off
• Press the Power button to turn on the analyzer.

The startup screen appears. Or, if resuming operation after a timeout, the last
screen appears.

• Press and hold the Power button for one second to turn off the analyzer.

If the power-saving timeout feature is enabled, the analyzer turns off automatically
after several minutes.

3.2 Using the touchscreen interface
The CSI 2125-IS has a touchscreen interface. You can use your finger or the included stylus
to make selections on the screen. Most operations can be completed with the touchscreen
interface. However you must use arrow keys for some actions, such as navigating through
a route. If the screen becomes unresponsive, wait a moment to allow the system to
respond.

Operate the analyzer
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3.3 Calibrate the touchscreen interface
Calibrate the touchscreen interface when the screen no longer responds as expected.

Procedure

1. Go to Instrument Setup > Touchscreen and select Calibrate.

The calibration screen displays a series of crosses on the screen.

2. Tap the center of the crosses with your finger or stylus.

The touchscreen is calibrated.

3.4 Assemble the strap
Feed the ends of the strap through the top and bottom pillars on the left or right side of
the analyzer, as shown in Figure 3-1.

Assemble the strapFigure 3-1:   

3.5 Display hardware and firmware details
Record your device information if you need to contact Technical Support.

Procedure

1. From the Main Menu, press About.
2. Record the Unit ID, Firmware Version, and disk space information to provide to

Technical Support.

Operate the analyzer
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3. Press Info to obtain details about the firmware build.

4. Record this information for reference.

Unit ID

Firmware Version

Internal Disk % Free

Firmware Build Information

Notes

3.6 Charge the battery
Charge the battery using the provided power adapter with the analyzer. If the battery
discharges completely, the analyzer's hardware resets and the current date, time, and
status information, such as the last route opened resets.

Important
Only use the power adapter provided. Using any other power adapter will render the certification
permanently invalid and may cause permanent damage to the analyzer.

WARNING!

Charge the battery only in a Non Hazardous Area.

Note
The battery will stop charging if the ambient temperature is too high (>40°C). Always charge the
battery in a well-ventilated area, and allow longer for the battery to charge if the ambient
temperature is high. If you intend to use the CSI 2125-IS in a high ambient temperature, take the
instrument off charge at least 2 hours before use.

Tip
If the battery has not been used for some time you may have to cycle it (fully charge and then
discharge it) once or twice to renew the full capacity of the battery.

Procedure

1. Connect the provided power adapter to an electrical outlet.

2. Align the red dots on the connector to the CHARGER socket on the analyzer and
press the connector into the socket.

When the power adapter is connected, the red LED indicates the battery charging
status.

Operate the analyzer
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Red LED State Description

Flashing Power adapter detected

Flashing continuously If the red LED continues to flash and does not change to solid after
30 seconds, this indicates a fault in the main battery and the
battery will not charge. For example, the cell temperature is too
high.

On Charging

Off Fully charged

The red LED flashes and turns solid. If the analyzer is turned on, the battery status

displays the  icon.

3. (Optional) Turn off the analyzer for fastest charging.

When the battery is fully charged, the red LED turns off. The battery does not lose charge
while the power adapter is attached.

3.7 Display the battery status
Press the dot (.) button to display detailed battery status information when the analyzer is
turned on. Table 3-1 describes the battery status displayed on the top right of all screens.

Battery status iconTable 3-1:   

Icon Status Battery Life

Good 70-100%

Medium 35-70%

Low 15-35%

Very Low <15%

Charging

3.8 Remove and refit the battery pack

WARNING!

Open the battery access door only in a Non Hazardous Area.

Procedure

1. Turn off the analyzer.

Operate the analyzer
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2. Loosen the quarter-turn fasteners on the back of the analyzer.

3. Open the battery access door.

4. Release the locking tab to the right of the battery.

5. Lift the battery out of the analyzer.

6. Reinsert the battery. Press it until the locking tab latches and the battery does not
move.

7. Replace the battery access door and tighten the quarter-turn fasteners.

3.9 Reboot the analyzer
You can reboot the analyzer's operating system to reset the analyzer and retain the factory
default settings, including the current date, time, contrast setting, and some status
information.

You can reboot instead of performing a hardware reset if the analyzer becomes
unresponsive. For example, if you disconnect the analyzer's cable from the computer while
a route is loading, you may need to reboot the analyzer or perform a hardware reset. Refer
to for instructions.

Procedure

Press and hold keys 7, 8, 9, and 2.

Allow at least 30 seconds for the analyzer to reboot and activate the display.

3.10 Perform a hardware reset

WARNING!

Open the battery access door only in a Non Hazardous Area.

Perform a hardware reset to return the analyzer to the factory default settings, including
the current date, time, contrast setting, and some status information. Refer to Section 3.9
to reboot the analyzer and retain settings.

Procedure

1. Turn off the analyzer.

2. Loosen the quarter-turn fasteners on the back of the analyzer.

3. Open the battery access door and locate the reset switch.

4. Insert a pin (1/16th inch in diameter) or straightened paper clip into the reset switch
and press the reset button.

5. Replace the battery access door and tighten the quarter-turn fasteners.

Operate the analyzer
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Postrequisites

Turn on the analyzer. Allow at least 30 seconds for the analyzer to reconfigure and activate
the display.

3.11 Update the CSI 2125-IS firmware

WARNING!

Only update the firmware in a Non Hazardous Area.

When directed by customer support, you can load a new operating system (OS) image on
a CSI 2125-IS analyzer to perform field-installable updates.

Procedure

1. Turn off the analyzer.

2. Loosen the quarter-turn fasteners on the back of the analyzer.

3. Open the battery access door and locate the reset switch.

4. Insert a pin (1/16th inch in diameter) or straightened paper clip into the reset switch
and press the reset button.

5. Replace the battery access door and tighten the quarter-turn fasteners.

6. Connect the power adapter to the analyzer and an electrical outlet.

Important
Do not perform firmware updates while operating on battery power.

7. Press and hold the left and right arrow keys simultaneously and press the Power
button.

The analyzer boots and displays the Engineer Mode menu.

Operate the analyzer
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Engineer Mode menuFigure 3-2:   

A. Bootloader version
B. Unit ID number
C. Run Windows CE: run the current firmware

loaded in the CSI 2125-IS analyzer. Some
settings that are stored in the registry,
such as date and time will need to be reset
after performing this action.

D. Load OS image via RS232: load a new
firmware to the CSI 2125-IS analyzer

E. Load OS Image from CF Card: unsupported
option by the CSI 2125-IS analyzer.

8. On the analyzer, Press 2 to select Load OS image via RS232.

9. Connect the analyzer to the computer using the serial cable.

10. Run WinSerDL.exe on the computer.

A dialog titled WinSerDL opens.

WinSerDL dialogFigure 3-3:   

11. In WinSerDL, select File > Open and browse to the location of your firmware update.

Note
A firmware update file has an .out extension (for example v100.out for version 1.00). You may
need to change the Files of type selection to All files (*.*) to see the update file.

A status message says "Ready to start download."

12. Select the CSI 2125-IS option from the Target (addr) menu.

Operate the analyzer
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13. Select a port for Com Port, if different from COM1 (default).

14. Click Start Download to begin the firmware update.

The update takes several minutes. A message will display when the update is
complete.

15. When the update is complete, on the analyzer, press 1 to select Run Windows CE and
launch the updated operating system.

3.12 Adjust the display contrast
You can adjust the display contrast from any screen.

Note
When the ambient temperature increases the screen may darken. This is normal behavior.

Tip
If you practice adjusting the contrast with this procedure when the screen is viewable in normal
temperatures, you will be able to adjust the contrast if the screen has gone completely black in a very
hot environment. Adjusting the contrast brings the screen back to a visible state within its allowable
temperature range.

Procedure

1. From any screen, press the 0 key to expose alternate software function keys.

The Cont.- and Cont.+ keys appear in the same positions (software function key 2 and
software function key 3) in the alternate software function key menu. Figure 3-4
shows the positions of the contrast controls.

Operate the analyzer
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Contrast controls on alternate software function keys menuFigure 3-4:   

2. Press Cont.- (software function key 2) to lighten the display.

3. Press Cont.+ (software function key 3) to darken the display.

4. Press 0 to revert to the normal function keys.

The Cont.- and Cont.+ keys remain visible for approximately 3 seconds. Repeat this
procedure until the screen is at the desired contrast level.

3.13 Open context sensitive help
Press Help from any screen to read help messages for that screen.

Operate the analyzer
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4 Configure the analyzer
Topics covered in this chapter:

• Instrument Setup screen

• Change instrument setup

• Instrument Configuration screen

• Change global settings for data collection

• Instrument configuration and route measurement limitations

4.1 Instrument Setup screen
The Instrument Setup screen allows you to change settings for power, communication,
and date and time.

Option Values Description

Timeout 5 min | 10 min |
15 min | 20 min |
Off

Period of inactivity before the analyzer turns off
automatically; no data is lost. Press the Power key to
resume operation after a timeout. Choose Off to disable
this power-saving feature.

Baud Rate 1200 – 115200 Data transmission rate (bits/second). Default is 115200.

Dflt Units English | Metric Default units of measure: English (for example, in/s) or
Metric (for example, mm/s)

Date Format DD/MM/YYYY |
MM/DD/YYYY |
YYYY/MM/DD

Date format displayed on the analyzer.

Date/Time 24hr units Date and time displayed on the screen and recorded
during data collection.

Touchscreen Calibrate Run the touchscreen calibration program.

Memory Delete all routes |
Initialise

Delete all routes: remove all routes from memory.

Initialise: remove all files from memory, including any
routes and directories.

Purge Cache On | Off On: create a cached empty database file for faster purging
point data of large databases.

Off: maximize storage space; no empty database file is
created.

Configure the analyzer
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4.2 Change instrument setup
The Instrument Setup screen appears when you turn on the analyzer for the first time or
after you perform a hardware reset. You can change these settings at any time.

Procedure

1. From the Main Menu, select Instrument Setup and press Enter.

The Instrument Setup screen displays.

2. From the Instrument Setup screen, press the up or down arrow keys select a setting.

The selected setting is highlighted.

3. Press the right arrow key to edit the setting.

The selected value is highlighted.

4. Use the numeric keypad to enter a value, or press the up and down arrow keys to
cycle through options.

5. Press Enter to accept the value.

6. Press Apply to save changes and return to the Main Menu.

4.3 Instrument Configuration screen
The Instrument Configuration screen allows you to change global settings for data
collection.

Setting Values Description

Freq. Units Hz | CPM | Orders Display of x-axis data for spectrum/FFT data.

For example, fundamental frequency = 50Hz, 3000 CPM
or x1 order.

Orders data is only provided when order normalized or
phase data is collected using a tachometer or strobe to
trigger data collection, otherwise data is provided in
terms of CPM.

Auto Store On | Off On: automatically accept the overall measurement
when the measurement is within a certain percent
fluctuation for a period of time.

When Auto Store is On, you can change the Auto store
time (seconds) and Auto store percentage (percent) to
change how the overall is accepted.

Off: allows you to determine if the reading appears to be
stable as possible and then accept (save) the overall
measurement by pressing Enter.

Configure the analyzer
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Setting Values Description

Auto Advance On | Off On: automatically advance through all collections at this
part of the point.

Off: you must accept each data collection for each point
setup for each point in the route. Press Enter to accept.

Acquisition Single avg. |
Continuous

Only applies for spectrum signature collection with 1
average.

Single avg. (single average): collection stops after a
spectrum is collected and displayed.

Continuous (continuous spectrum): continuously
collect and display successive single average spectra
until you press Enter to stop collection. (Press Enter again
to store the data.)

Autoranging Aggressive |
Conservative

Aggressive: limits the auto-ranging to 20mV level and
sets the range limits to between 1% and 70% of range.

Conservative: Allows autoranging to go the lowest
range of 2mV level and sets the range limits to between
10% and 70% of range.

Mach. Speed Normal | Slow Normal: sets the autoranging algorithm to only track
signals above 120CPM.

Slow: sets the autoranging algorithm down to the Low
Pass Filter setting. If none, it shall track down to
approximately 20CPM (0.33Hz).

Settling Delay 0.00–60.00s Specifies a time to delay data acquisition after applying
power to an ICP® accelerometer to allow the sensor to
settle.

After placing a sensor at a location on a machine, it is a
good practice to allow at least 3-5 seconds for the
sensor to settle. If you collect data before the sensor has
settled, you could get ski-slope on your data.

Memory Purge | Delete Route |
Delete All Routes |
Initialise

Purge: Delete all data from routes, but keep the routes.

Delete Route: Select a route to remove.

Delete All Routes: Delete all routes and associated data.

Initialise: Delete all routes and data (and all other files)
from memory.

Fill Signature On | Off On: fill the space between the signature line and the X-
axis. This viewing preference could make the spectrum
easier to see and give it more contrast.

Off: do not fill the space.

Configure the analyzer

MHM-972125, Rev 2 19



Setting Values Description

Trig Level Fixed | Automatic Fixed: always use the point setup information from
either the route or off-route, depending on where the
measurement is taken. When you select Fixed, you
must also set Trig Hyst (Hysteresis) and whether or not
to use the pull up (Trig Pull Up).

Automatic: sample the trigger signal prior to beginning
data acquisition and select the most appropriate
settings.

Trig Hyst 0.25V | 0.5V | 1.25V |
2.5V

Hysteresis. Manually compensate for noise on a trigger
signal. The signal level must be at least twice the value
of the hysteresis value applied for successful triggering.
This setting applies if Trig Level is set to Fixed.

Trig Pull Up Off | On Off: (Default) Recommended.

On: Not recommended. Use for triggering from a
tachometer or other source with an open collector
output.

4.4 Change global settings for data collection
You can change global settings that control how data is collected and stored from the
Instrument Configuration screen. These settings are stored in flash memory. You can reset
these values to the system defaults by performing a hardware reset.

Procedure

1. From the Main Menu, select Data Collection and press Enter.

Data Collection screen with route selectedFigure 4-1:   

The Data Collection screen displays routes loaded on the analyzer.
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2. From the Data Collection screen, select the Config software function key.

The Instrument Configuration screen displays.

3. From the Instrument Configuration screen, press the up or down arrow keys to
select a setting.

The selected setting is highlighted.

4. Press the right arrow key to edit the setting.

The selected value is highlighted.

5. Use the numeric keypad to enter a value or press the up and down arrow keys to
cycle through options.

6. Press Enter to accept the selected value.

7. Set other settings, as desired.

8. Press Apply to save changes and return to the Main Menu.

4.5 Instrument configuration and route
measurement limitations
This section describes limitations of the CSI 2125-IS analyzer. Contact customer support
for more information about software and firmware updates that address these issues.

Data collection

The CSI 2125-IS is designed is to acquire one data type (and one data unit) per
measurement point. Whereas, other CSI-branded analyzers acquire multiple data types
and data units simultaneously. Turn on Auto Advance (in the Instrument Configuration
screen) so the CSI 2125-IS can acquire all the data types and data units on a single point
when you press Enter during data collection. If you do not use Auto Advance, you must press
Enter to collect each type of data at each measurement point.

Transferring off-route data from the analyzer

The CSI 2125-IS analyzer is capable of collecting data that is not supported in an AMS
Machinery Manager database. Be aware of the following limitations as you collect off-route
measurements.

Averaging The CSI 2125-IS does not support time synchronous averaging
(TSA) or order track averaging. If a route contains these
measurements, they will not be transferred to the CSI 2125-IS.
Data Transfer displays a notification.

Fmax values above
40KHz

If a route has parameters with Fmax set above 40KHz, Data
Transfer scales the Fmax back to 40KHz when the route is loaded
in the CSI 2125-IS. This is the same behavior for the CSI 2120. Any
parameters above 40KHz are not calculated.
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Manually enter
measurements

You can type in a temperature measurement but it will not be
saved in the AMS Machinery Manager database.

Non-vibration data Data Transfer does not load non-vibration points to the CSI 2125-
IS. Non-vibration data such as current, voltage, temperature, can
be collected with the analyzer but Data Transfer ignores such non-
vibration data when transferring data to the database.

Off-route data Off-route measurements are associated with a route point. Off-
route measurements other than spectra and waveform will not be
stored in AMS Machinery Manager.

Transferring routes to the analyzer

AMS Machinery Manager routes may contain measurement points that are not supported
in the CSI 2125-IS analyzer. Be aware of the following limitations as you create routes and
transfer routes to the CSI 2125-IS analyzer.

Maximum routes
limit

The CSI 2125-IS analyzer can hold up to 31 routes internally,
provided there is enough available memory.

Maximum route
point limit

The CSI 2125-IS analyzer can hold up to 1500 points in any single
route.

Fault frequency Fault frequencies are not supported.

Force into
database

With the CSI 2125-IS, the "Force into Database" function can only
work if the target database has the same route.

Integration mode The CSI 2125-IS supports analog. Digital is not supported.

Unsupported
collection types

The CSI 2125-IS does not support points set up to collect non-
vibration dynamic signals, such as general dynamic, pressure,
current, flux, or shaft probe data. In addition, it does not support
spectral weighting of A-Weighting, 1/3 octave analysis, SST, or
demodulation.

Override analog
overall

If you have a route set up for analog overall, Data Transfer converts
the route to digital overall when downloading to the analyzer.

PeakVue PeakVue points will only be transferred to the CSI 2125-IS if the
firmware version of the CSI 2125-IS supports PeakVue.

Special Time
Waveform

The CSI 2125-IS does not support triggered waveforms.

Trends Trend data is supported as long as it is a parameter that is either
the energy within a band or the peak value within a band. Also, the
upper end of the band must be less than or equal to 40KHz.
Waveform parameters are supported.

Variable Speed
Machines

For variable speed machines, orders, spectrum, and waveform will
be collected based on reference speed. If the speed of the machine
is not running at the reference speed, parameters based on orders
will not be calculated correctly.

Vibration The CSI 2125-IS supports vibration data points set up to collect
data using conventional vibration sensors. Note that only a limited
number of sensors are certified for use with this meter in a
hazardous environment.
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Waveform size The CSI 2125-IS supports maximum waveform block sizes up to
16384 points.

Other route management notes

Loading routes with more than 500 points can be noticeably slower than loading smaller
routes. Consider dividing your large route into smaller routes.

Routes with more than 50 machines, or machines that contain more than 50 points can be
very slow to update in the analyzer's Route Navigation screen.

Points with a high number of lines require more memory, so consider using lower
resolutions (e.g. 800 or 1600 lines rather than 3200 or 6400 lines). To conserve memory,
only load the routes you require for the day's work and delete unused routes from the
analyzer.
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5 Collect data
Topics covered in this chapter:

• Data Collection screens

• Overall screen

• Signature screen

• Analysis functions in Data Collection mode

• Collect data from equipment on a route

• View current point information

• Add a note to a measurement point

• Collect an off-route measurement

5.1 Data Collection screens
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5.2 Overall screen
The Overall screen appears during data collection(1).

Overall screenFigure 5-1:   

A. Point details
B. Current signal amplitude
C. Last recorded value
D. Change from last recorded value
E. Full scale range
F. Upper alarm level (if set)
G. Lower alarm level (if set)

(1) The Notes software function key is present in data collection mode only.
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5.3 Signature screen
The Signature screen appears during data collection.

Signature screenFigure 5-2:   

A. Point details
B. R, in continuous acquisition mode

denotes real time data capture
C. Amplitude scale
D. Cursor
E. Cursor position values (calculated

overall, frequency, amplitude)
F. Harmonic cursors
G. Fmax

5.4 Analysis functions in Data Collection mode
Table 5-1 describes the analysis functions available from the Overall and Signature screens.

Analysis functions during data collectionTable 5-1:   

Key Function

Enter Store data.

Help Read help about the current screen.

Esc Escape to the route.

Notes From the Data Collection screen, press Notes to add an observation.

Up Arrow Decrease amplitude scale (y-axis).

Down Arrow Increase amplitude scale (y-axis).

Left Arrow Move cursor left.

Right arrow Move cursor right.

4(H) Display 32 harmonic cursors. Press again to alternate between harmonic
and fixed cursors.
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Analysis functions during data collection (continued)Table 5-1:   

Key Function

7(P) Locate next peak value.

. Press to alternate the +- key between expand and compress.

0 Shift. Alternates software function keys to show other software function
keys, for example: Off-route, Cont.-, and Cont.+ keys to adjust contrast).

+- Expand/Compress signature. Press to expand or compress the Frequency/
CPM/Orders axis (trace) three levels. Press . then +- to switch to compress
the trace three levels.

5.5 Collect data from equipment on a route

WARNING!

Use only the certified transducers listed in Section 1.3 in Hazardous Areas.

Prerequisites

Load a route using AMS Machinery Manager Data Transfer.

Procedure

1. From the Main Menu, select Data Collection and press Enter.

Data Collection screen with route selectedFigure 5-3:   

The Data Collection screen displays routes loaded on the analyzer.

2. Select a route using the up and down arrow keys.

3. Press the right arrow key to expand the route.
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An active route is marked with a < symbol and the route contents displays. An x
indicates no data has been collected at a point, or the area has measurement points
that have not been collected. When data has been collected, the x is replaced by a
check.

4. Navigate to the first measurement point and press Enter.

a. Press the right and left arrow keys to navigate through the database (DB.), area
(Area), machine (Mach), and point (Point).

b. Press the up and down arrow keys to make a selection within a level if multiple
options are available.

Data Collection screen with a point selectedFigure 5-4:   

The route is registered (if necessary) and data collection begins automatically on the
first point accessible from the place in the route structure where you pushed Enter.

Note
You can push Enter before or after the route is registered.

5. Connect the transducer from the analyzer's SIGNAL socket to the measurement
location on the equipment corresponding to the selected route measurement point.

6. Press Enter to start data collection.

The LEDs will indicate the system status:

• Red indicates the transducer is not attached (prior to data collection).

• Amber indicates the system is settling.

• Green indicates the system is taking data and preparing to store data.

The "Collecting Data..." message displays, followed by a screen showing the data
collected.

7. Press Enter to store the data and collect the next measurement at this point or to
move to the next measurement point.
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When all the measurements are collected for this point, the Data Collection screen
automatically selects the next point in the route.

Data Collection screen with next point selectedFigure 5-5:   

8. Repeat Step 5 – Step 7 until all the measurements are collected.

When the route is complete, the route contains a check.

5.6 View current point information
You can view a list of details for a point.

Procedure

1. Navigate to a point in a route and select Help.

The Help screen appears.

2. Press Pt. Info.

A list of point details appears.

3. Press ESC to go back to the route.

5.7 Add a note to a measurement point
Your observations of the equipment are a very important part of data collection. You can
add and remove notes during data collection or while reviewing data. You can add up to 6
predefined note codes per measurement point. Note codes are defined in the AMS
Machinery Manager database and are associated with the route. You can add notes during
data collection or later.
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Procedure

1. From the Data Collection screen, navigate to a measurement point and press Enter.

The Overall screen opens.

2. Press Notes from the Overall screen or Signature screen.

The notes dialog opens displaying a list of note codes.

3. Choose a note code using the up and down arrow keys and press Select to select the
highlighted note.

A check appears to the right of a selected note.

4. Select up to 6 note codes and press Save.

Or, press Cancel to discard selected notes and return to the route.

5.8 Collect an off-route measurement
When you are collecting data on a route, you may collect an off-route measurement
associated with a point in a route. You can select a point by navigating to a point in the
route. However, if you do not select a point, the analyzer selects the last point measured
(during data collection) or the first available point (if no data has been collected for the
route).

Note
You may configure points and collect data with all the options on this analyzer. However, only
supported measurements will be transferred to AMS Machinery Manager. Refer to Section 4.5 for
more information.

WARNING!

Use only the certified transducers listed in Section 1.3 in Hazardous Areas.

Prerequisites

Load a route using AMS Machinery Manager Data Transfer.

Procedure

1. Connect the transducer to the analyzer.

If no transducer is attached during data collection, an error dialog box appears on
the screen. No measurements can be taken without a transducer.

2. Go to the Data Collection screen.

The Data Collection screen displays routes loaded on the analyzer.

3. Press Off-route.
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The Off-route screen appears.

4. Choose a measurement configuration from the Off-route menu:

Point Description

Same Same as the current point (last point measured in the route).

Opposite Opposite from the current point (last point measured in the route) where
Spectrum becomes Time or Time becomes Spectrum.

ACCEL Acceleration Spectrum measurement. 10kHz, 800 lines, 4 averages.

Velocity Accel –> Velocity Spectrum measurement. 2kHz, 400 lines, 4 averages.

ACCEL TIME Time measurement. 10kHz, 2048 points.

High Res High-Resolution measurement set up the same as the current point (last
point measured in the route). Increased number of lines by a factor of 2. For
example, a measurement having 400 lines becomes 800 lines.

User User defined measurement. Configure a measurement from a menu of all
measurement settings. Changes you select in the User menu apply to the
current measurement only. The menu resets when you exit the User menu.

The <RouteName> (Off-route) screen appears.

Note
<RouteName> represents the last selected route.

5. Connect the transducer from the analyzer's SIGNAL socket to the measurement
location on the equipment corresponding to the selected route measurement point.

6. Press Enter to start data collection.

The LEDs will indicate the system status:

• Red indicates the transducer is not attached (prior to data collection).

• Amber indicates the system is settling.

• Green indicates the system is taking data and preparing to store data.

The "Collecting Data..." message displays, followed by a screen showing the data
collected.

7. Enter a note for this point, if desired.

8. Press Enter store the data to return to the Off-route screen.

The <RouteName> (Off-route) screen displays the new point information.

5.8.1 Set up a user-defined measurement
1. From the Off-route screen, select User.

2. Update the settings that apply to the measurement you want to collect.
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a. Highlight a setting using the up and down arrow keys.

b. Press the right arrow key to edit the option.

c. Change the option with the up or down arrow keys or by typing in a value.

d. Press the left arrow key to accept the option and return to the settings.

3. Press Enter to collect and store data.

The User screen appears.
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6 Review data
Topics covered in this chapter:

• Review Overall screen

• Review Signature screen

• Analysis functions in Review Data mode

• Review collected route data

• Review collected off-route data

6.1 Review Overall screen
The Review Overall screen appears during data review(1).

Review Overall screenFigure 6-1:   

A. Point details
B. Current signal amplitude
C. Last recorded value
D. Change from last recorded value
E. Full scale range
F. Upper alarm level (if set)
G. Lower alarm level (if set)

6.2 Review Signature screen
The Review Signature screen appears during data review.

(1) The Notes software function key is not present during data review; it is present in data collection.
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Review Signature screenFigure 6-2:   

A. Point details
B. Amplitude scale
C. Cursor
D. Cursor position values (calculated

overall, frequency, amplitude)
E. Harmonic cursors
F. Fmax

6.3 Analysis functions in Review Data mode
Table 6-1 describes the analysis functions available from the Review Overall and Review
Signature screens.

Analysis functions in Review Data modeTable 6-1:   

Key Function

Enter View the next stored data.

Help Read help about the current screen.

Esc Escape to the route.

Up Arrow Decrease amplitude scale (y-axis).

Down Arrow Increase amplitude scale (y-axis).

Left Arrow Move cursor left.

Right arrow Move cursor right.

4(H) Display 32 harmonic cursors. Press again to alternate between harmonic
and fixed cursors.

7(P) Locate next peak value.

. Press to alternate the +- key between expand and compress.

0 Shift. Alternates software function keys to show other software function
keys, for example: Off-route, Cont.-, and Cont.+ keys to adjust contrast).
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Analysis functions in Review Data mode (continued)Table 6-1:   

Key Function

+- Expand/Compress signature. Press to expand or compress the Frequency/
CPM/Orders axis (trace) three levels. Press . then +- to switch to compress
the trace three levels.

6.4 Review collected route data
1. From the Main Menu, select Review Data.

2. Navigate to a measurement point and press Enter.

The Overall screen opens.

3. From the Overall screen, press Enter to go to the next screen.

4. Press Enter to open the Signature screen.

Note
You can push Enter before or after the route is registered.

6.5 Review collected off-route data
1. From the Main Menu, select Review Data.

2. Press 0 to display alternate software function keys.

The Off-route software function key displays.

3. Press Off-route to view off-route data.
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7 Transfer data
Topics covered in this chapter:

• Transfer files with CSI 2125-IS analyzers

• Connect the CSI 2125-IS

• Load a route from AMS Machinery Manager to the analyzer

• Dump a route from the analyzer to AMS Machinery Manager

• Working with routes as files

• Delete a route from the analyzer

• Disconnect the analyzer from AMS Machinery Manager

7.1 Transfer files with CSI 2125-IS analyzers
AMS Machinery Manager Data Transfer

AMS Machinery Manager Data Transfer lets you manage the route files in your analyzer.
You need Data Transfer so you can transfer routes between the AMS Machinery Manager
database and your analyzer.

You can do the following:

• Transfer routes from AMS Machinery Manager to the analyzer for data collection.

• Transfer routes from the analyzer to the AMS Machinery Manager database for
storage and analysis.

• Transfer and store routes between the analyzer and a folder on your computer.

• Create route definition files and route data files that you can email to others.

AMS Machinery Manager Standalone Data Transfer

If your computer does not have AMS Machinery Manager installed, use the AMS Machinery
Manager Standalone Data Transfer application to transfer route files between an analyzer
and a local folder on the computer. The Standalone Data Transfer does not have a
database, so all files are transferred to a computer folder.

The AMS Standalone Data Transfer software is available on the AMS Machinery Manager
installation media.

Limitations:

• You cannot install Standalone Data Transfer on the same computer as AMS
Machinery Manager.

• You cannot create routes. You can only transfer files.

• You cannot save files directly to the AMS Machinery Manager database.
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7.2 Connect the CSI 2125-IS

WARNING!

Connect the analyzer to a computer only in a Non Hazardous Area.

Procedure

1. Connect the supplied serial cable to the computer and the RS232 socket on the
analyzer.

Note
If your computer does not have a serial port, use the supplied serial-to-USB cable. Install the
serial-to-USB driver (from the CD-ROM included with your analyzer) before using the cable for
the first time.

2. Turn on the analyzer.

3. On the computer, open Data Transfer.

4. Click the Enable Device menu and select your analyzer.

A device status box with an icon, name, and status appears in the workspace.

5. If more than one analyzer is enabled, click a device status box to select an analyzer.

The selected analyzer's options appear in the Options pane.

6. Click the Options icon to expand the Options pane.

7. Set the connection type in Data Transfer to match the analyzer's communication
setup options and click Apply.

8. Click Connect.

The device status updates in the Devices waiting for connection pane and a tab
displays any route names and status.

Important
Do NOT press buttons on the CSI 2125-IS or unplug the serial cable while the analyzer is
connected in Data Transfer. The analyzer will no longer be physically connected, but the
software will appear to be connected. The connection status updates automatically after a
timeout period. Refer to Section 7.7 for instructions to safely disconnect the analyzer.

7.3 Load a route from AMS Machinery Manager to
the analyzer
Procedure

1. Connect to the analyzer.
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2. In Data Transfer, select the appropriate database from the Navigation - Data
Transfer pane.

3. Drag and drop or copy and paste the route to the connected analyzer in the
workspace.

The Data Transfer Notification pane displays the progress of the transfer.

The list of files in the analyzer's tab contains the new route. The Notifications Pane lists the
analyzer's available remaining memory.

7.4 Dump a route from the analyzer to AMS
Machinery Manager
Once you have collected data on the analyzer, dump the route to AMS Machinery Manager
for storage and analysis.

Procedure

1. Connect to the analyzer.

2. In Data Transfer, locate the route you want to import from the analyzer's tab.

3. Locate the appropriate database in the Navigation - Data Transfer pane.

4. Drag and drop or copy and paste the desired route from the analyzer's tab to the
database in the Navigation - Data Transfer pane.

The Data Transfer Notification pane displays the progress of the transfer.

Postrequisites

In AMS Machinery Manager, go to the Vibration Analysis tab to analyze your data.

7.5 Working with routes as files

7.5.1 Create a route file to send to another user
You can create intermediate route definition file to send to another user. The remote user
can transfer the route definition file to a connected analyzer with the AMS Standalone Data
Transfer application or with an AMS Machinery Manager Client. For example, you may
email this file to a remote user who needs to collect data with an analyzer, but does not
have an AMS Machinery Manager Client or a database.

Procedure

1. In Navigator, locate the route you want to transfer to the other user.

2. Drag-and-drop the route to the File Transfer pane.

The route name appears in the File Transfer pane. The route definition file is saved to
the Working Directory folder.
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3. Click Explore to open the folder in Windows Explorer.

Windows Explorer opens and displays a route definition file named in the following
format <route name>_<identification string>.RDF. RDF stands for Route Definition File.

Postrequisites

Send the route definition file to the user by email or using a File Transfer Program, for
example.

7.5.2 Load a route from a file to the analyzer
1. Connect to the analyzer.

2. In Data Transfer, open the File Transfer pane.

3. In the File Transfer, click Working Directory and select a folder on the computer to store
the file.

4. Copy the route definition file (file with an .RDF extension) emailed to you to this
folder in Windows Explorer.

The File Transfer pane displays the name of the route under the Vibration Route
Definition heading.

5. Drag and drop or copy and paste the route to the connected analyzer in the
workspace.

The Data Transfer Notification pane displays the progress of the transfer.

The list of files in the analyzer's tab contains the new route.

7.5.3 Dump a route from the analyzer to a folder on a
computer
You can transfer a route from a connected analyzer to a file to send to an AMS Machinery
Manager user (by email, for example).

Procedure

1. On the computer, open Data Transfer.

2. Connect to the analyzer.

3. Click View > File Transfer.

The File Transfer pane appears at the bottom of the screen.

4. Click the Working Directory link in the File Transfer pane, and select a folder on the
computer to store the file.

5. Click OK.

6. On the computer, drag and drop or copy and paste one or more files from the top
pane displaying the analyzer files to the File Transfer pane at the bottom of the
screen.
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The transferred files appear in the File Transfer pane. The route data file is saved to
the Working Directory folder.

7. Click Explore to open the folder in Windows Explorer

Windows Explorer opens and displays a route data file named in the following
format <route name>_<identification string>. RDT.

Postrequisites

Transmit the route data file to the user by email or using a File Transfer Program, for
example.

7.5.4 Dump a route from a file to AMS Machinery Manager
Dump data from a route data file on a computer to the AMS Machinery Manager database.

Procedure

1. On the computer, open Data Transfer.

2. Open the File Transfer pane.

3. Click the Working Directory link in the File Transfer pane, and select a folder on the
computer to store the file.

4. Click OK.

5. Click Explore in the File Transfer pane to open Windows Explorer to the Working
Directory location.

6. Copy the route data file (file with an .RDA or .RDT extension) to this folder and close
Windows Explorer.

The name of the route displays in the File Transfer pane. (Press F5 to refresh the
screen.)

7. Drag and drop or copy and paste the route from the File Transfer pane to the
Navigator pane.

7.6 Delete a route from the analyzer
The CSI 2125-IS can hold up to 31 routes, provided there is enough free space. When you
transfer a route to the analyzer, the Data Notifications pane displays a message with the
available remaining memory. If you run out of space, you can delete routes from the
analyzer.

Dumping a route transfers the contents of a route to the AMS Machinery Manager
database. The route and its data remains in the analyzer until they are deleted. You can
remove a route from the analyzer in Data Transfer when an analyzer is connected.
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Tip
Before deleting a route from the analyzer, dump the route to the database or dump the route to a
file on the computer.

Procedure

1. Connect to the analyzer.

2. In the analyzer's tab, right-click the route you want to delete and select Delete.

The route is removed from the analyzer.

7.7 Disconnect the analyzer from AMS Machinery
Manager
When an analyzer is connected in AMS Machinery Manager or AMS Machinery Manager
Standalone Data Transfer, there are several safe ways to disconnect the analyzer.

• In the Workspace, right-click the device icon and select Disconnect Device.

• In the Workspace, open the connected analyzer's tab and click the Disconnect icon.

• Shut down AMS Machinery Manager or AMS Machinery Manager Standalone Data
Transfer.

The device icon's status message changes from "Connected" to "Ready to Connect". Your
analyzer is still enabled.

Transfer data

44 MHM-972125, Rev 2



Appendix A
Product specifications

Physical dimensions (with rubber protective boot)

Height 207 mm (8.07 in)

Width 100mm (3.93 in) at narrowest point

134mm (5.90 in) at widest point

Depth 5.5 mm (2.17 in)

Weight 850g (1.6 lbs)

Display 1/4 VGA : 240 x 320 LCD, touchscreen, backlit

58mm x 77mm viewable

Connector panel

PC Comms RS232 - 9 way D Type (Plug)

RS-232 serial port: up to 115k baud

I/O 2 pin: Power In/Battery Charge

4 pin: Signal

3 pin: Trigger

Connector positions

Pin TRIGGER (3-
pin)

CHARGER (2-pin) RS-232, 9 way (plug)
D Type

SIGNAL (4-pin)

1 Trigger in Ext-DC-IN Signal In

2 Ground TxD-OUT ICP® In

3 Ground RxD-IN Ground

4 DTR OUT Ground

5 Ground

6 CTS-IN

7 RTS-OUT

8

9

Battery/power

Battery type Rechargeable Nickel Metal Hydride (NiMH) Pack.

Product specifications
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Battery/power

I/O 1800 mAhr

Battery life, ON 8 hours continuous use

Battery life, OFF 7 days

Charging method In analyzer with power adapter

Charge time, 100% power 8 hours

Charge time, 50% power 3.5 hours

Performance

Operating system Windows CE V2.12

Processors MIPS R4000, DSP Motorola 56307

OS storage (for WinCE and applications) 16 Mbytes FLASH

Internal flash disk (for data and applications) 8 Mbytes FLASH

Internal RAM 8 Mbytes SDRAM

Environmental

Certification (IS)

Sealing IP65

Drop test 1 meter (to Mil-Std 810)

Temperature range Operating: -10 to +50 deg C

Storage: -20 to +60 deg C

Humidity Operating: 0 to 85% relative humidity

Product specifications
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Glossary

alarm An indication that the parameters of a machine have changed in a significant manner.

alarm limits Amplitude levels that define an alarm condition on the equipment being monitored.

alert An alarm limit calculated by the software which indicates that equipment is
approaching failure. Designated as a "C" alarm in reports.

aliasing An effect that results in erroneous frequency spectra when the frequency of the signal
being sampled is more than 0.5 times the sampling rate. CSI analyzers include anti-
aliasing filters that eliminate these errors.

amplitude Indicates the strength (magnitude in RMS, peak, peak-to-peak, average, or D.C.) of a
measured signal.

analysis parameter
set

Includes individual analysis parameters, and also contains instructions that tell the
machinery analyzer how to acquire data.

analysis
parameters

Divides the frequency spectrum into bands that are individually measured and
analyzed.

autorange The process of automatically adjusting the input instrumentation amplifier of the
analyzer to match the amplitude of the vibration signal. This process results in
increased dynamic range.

baud rate Unit of speed for data transmission over a serial communications link.

cursor A manually controlled marker that can be moved across a spectrum or waveform plot
display indicating time or frequency and amplitude at the cursor location.

cycles per minute,
CPM

The unit of frequency in cycles per minute. Equal to Hz x 60.

Data Transfer An application within AMS Suite: Machinery Health Manager that facilitates the
transfer of data in the form of a route between the AMS Suite: Machinery Health
Manager database and analyzers.

displacement
Refers to the distance that an object moves, usually considered to be the overall
range of movement; measured in mils or microns. Displacement is often measured
from eddy current probes and represents the physical movement of a rotating shaft
relative to its supporting bearing.

Sometimes accelerometers or velocity probes are used, and the data is integrated
into displacement. In this case, movement represents the displacement of the
equipment casing where the probe is mounted.

equipment Machinery that includes one or more rotating, stationary, electrical, and structural
components such as motors, gearboxes, fans, and pumps, for example. Each
component has a set of measurement points.

fast fourier
transform, FFT

An efficient computational process which allows the conversion of a signal's time
waveform into a frequency spectrum.

filter A device which removes certain frequencies from a signal while preserving the rest of
the signal.

Glossary
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frequency Number of times an event repeats in a unit of time; usually expressed in hertz (Hz) or
cycles per minute (CPM).

fundamental
frequency

The frequency of the peak from which related harmonics are referenced. 1xRPM is an
example of a fundamental frequency.

hanning Type of window applied to waveform data before frequency analysis; used to prevent
peaks in a frequency spectrum from spreading out due to a phenomenon called
leakage. The Hanning window is recommended for most frequency analysis
measurements where the signal is steady-state.

harmonic An integer multiple of a fundamental frequency f0 (example 2f0, 3f0, 4f0, etc.).

harmonic marker A box marker that appears on a spectrum display to indicate the harmonic peaks of a
fundamental peak.

hertz, Hz The unit of frequency in cycles per second.

high-frequency
detection, HFD

The amplitude of vibration in g's over a broad frequency band from 5 kHz up to 20 kHz
or greater.

lines The number of lines of resolution used for the spectrum calculation. Resolution (in
Hz) equals maximum frequency divided by the number of lines.

measurement
point

Any location or point on a machine where measurements are made.

mil A unit of measure for displacement (one thousandth of an inch).

notes
Specific observations that can be stored on the measurement point of a piece of
equipment along with collected data. Notes can be predefined from the database or
entered on an analyzer.

peak The largest signal level seen in a waveform over a period of time. For sinusoidal
signals, the peak signal level is always 1.414 times the RMS value of the signal level.
For non-sinusoidal signals, the peak level is often larger than the result that this
formula would produce.

peak-to-peak The difference between the maximum and minimum signal levels over a period of
time. For a pure sinusoidal signal, the peak-to-peak level is two times the peak signal
level and 2.828 times the RMS value of the signal level. For non-sinusoidal signals, the
peak-to-peak level is often larger than the result this formula would produce.

period Time required to complete one cycle in a periodic signal.

phase 1xRPM phase represents the location of the shaft of a piece of equipment in degrees
(0 - 360) with respect to the tachometer pulse where the largest vibration occurs.

real-time Continuously updated data or plot, such as an FFT spectrum.

RMS The magnitude of a signal calculated or measured by the root mean square method.
Equal to 0.707 times the peak value for a pure sinusoidal signal.

route One or more machines and their respective measurement points organized in an
efficient sequence for data collection.

RS232 A serial, synchronous communication standard; a type designation for cables that are
used to connect communications ports on host computer, analyzer, and telephone
modems. Other types of connections are ethernet and USB.

subharmonics Vibration frequencies which are integer fractions of the running speed (example ½
RPM, 1/3 RPM, etc.) or some other fundamental frequency.
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tachometer Pulse signal used to measure shaft turning speed. This may also be used to
synchronize the acquisition of dynamic data.

transient A non-steady-state signal of finite duration; often refers to a startup or coastdown of a
piece of equipment.

trend Plotting a number of measurements of a parameter over time.

trigger Causes the analyzer to start collection of data upon the receipt of a specified dynamic
signal from a sensor.

uniform window Description of a uniformly weighted signal, where no special window shaping is
applied before frequency analysis. Sometimes used for collection of non-steady-state
data.

velocity A measurement of the time rate of change in the displacement of an object. Vibration
is often measured in velocity using a velocity sensor. Velocity can be measured also by
integrating an accelerometer signal.

vibration
parameters

Twelve frequency band-limited parameters which are measured from the vibration
signal. These parameters are defined in the analysis parameter set and are loaded into
the machinery analyzer for each point from the database. (Also called individual
analysis parameters.)

waveform Analog or digital representation of a signal or function displayed as amplitude vs.
time.

window See hanning window and uniform window.
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Index

A
accelerometer   2
Acquisition

continuous spectrum acquisition   18

single average acquisition   18

add note to measurement point   30

adjust contrast   14

alarm level   26, 35

alternate function key   14

amplitude   27, 35

amplitude scale
increase, decrease   27, 36

AMS Machinery Manager Data Transfer   39

AMS Machinery Manager Standalone Data Transfer   39

AMS Suite
Machinery Health Manager   5

analyzer limitations   21–23

arrow keys   5
Auto Advance   18

Auto Store   18

Autoranging
Aggressive   18

Conservative   18

B
battery

charge   9
charge time   45

icon   10

insert   10

life   45

remove   10

status   10

type   45

battery access door   6
Baud Rate   17

button
arrow keys   5
Enter   5
locations   5
names   5
on screen   5
power   5

C
CA-40   2
CA-61   2
cautions   2
certificate number   2
certification   2
change data collection settings   20

change from last recorded value   26, 35

CHARGER   6, 9, 45

cleaning   3, 4

collect off-route data   31

collect route data   28

communication setting   17

configure off-route measurement point   31

connect CSI 2125-IS   40

connector panel   45

connector positions   45

connectors   6
contrast

adjust   14

Cont.-   14

Cont.+   14

CPM   18

create route   39

create route files   41

CSI 2125-IS Machinery Health Analyzer   5
current signal amplitude   26, 35

cursor
harmonic   27, 36

move   27, 36

D
damage   3, 4

Data Collection screen   20

data collection settings   18

data review functions   27, 36

Data Transfer program   5
date format   17

Date/Time   17

delete
all data from routes   18

all routes   18

all routes and data   18

delete route from CSI 2125-IS   43

demodulation   21–23

dimensions   45
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disconnect analyzer   44

disk space usage   8
dump route   39

dump route from file   43

dump route to file   42

E
email route files   41

Engineer Mode Menu   12

environmental conditions   45

F
fasteners   6
file extension

.RDA   43

.RDF   41, 42

.RDT   43

firmware
update   12

firmware version   8
Fmax   21–23, 27, 35

force data into database   21–23

frequency at cursor   27, 35

frequency units   18

full scale range   26, 35

G
global data collection settings   20

H
hardware reset

instrument setup   18

harmonic cursors   27, 35, 36

hazardous area operation   2
help   15

Hysteresis   18

Hz   18

I
Instrument Configuration screen   20

Instrument Setup   17

Instrument Setup screen   18

interconnecting lead   2

K
keys

shortcut   27, 36

L
last recorded value   26, 35

LED
red, flashing   9
red, solid   9

load route   39

load route from file   42

load route to CSI 2125-IS   40

locate peak   27, 36

lower alarm level   26, 35

M
Machine Speed   18

manual measurement   21–23

Memory   18

N
noise on trigger signal   18

non-vibration data   21–23

Note   26, 27, 35

note codes   30

number keys   5

O
off-route   21–23, 31

operating in a hazardous area   2
order tracking   21–23

Orders   18

Overall screen   26, 37

override analog overall   21–23

P
peak data   21–23

PeakVue   21–23

point details   26, 27, 35

power
button   7
on/off   7

power adapter   9
power setting   17

precautions   3, 4

product specifications   45

Purge Cache   17

R
R   27

range   26, 35

reboot   11

reset switch   6
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reset to factory defaults   11

review collected route data   37

Review Data screen   37

review off-route data   37

Review Overall screen   35

Review Signature screen   35

route
delete from CSI 2125-IS   43

dump route from file   43

load from file   42

route definition file   41

route limit   21–23

route load to CSI 2125-IS   40

RS232   6, 40, 45

S
send route data by email   42

serial cable   40

Settling Delay   18

shortcut keys   27, 36

show alternate function keys   27, 36

SIGNAL   2, 6, 45

signature   27, 36

Signature screen   27, 37

soft reset   11

software function key   5
strap

attach   8
stylus   7

T
tachometer   2, 18

technical support   1, 2, 8

time synchronous averaging   21–23

Timeout   17

touchscreen
calibrate   17

transducer   2
trend   21–23

Trig Hyst   18

Trig Level   18

Trig Pull Up   18

TRIGGER   2, 6, 45

triggering   18

U
Unit ID   8
units of measure

English   17

Metric   17

upper alarm level   26, 35

USB   40

user-defined point   32

W
warm reboot   11

warnings   2
water   3, 4

windowing   21–23

Windows CE License Agreement   ii
WinSerDL   12
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